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Changes from MultiQuantTM 3.0.2 HotFix 2 to
Version 3.0.3
New Features

• Support for Microsoft Windows 10 operating system.

• Support for Microsoft Office 2016.

• The actual ratio and expected ratio of MRM2/MRM1 in the row for MRM1 are now shown.

• Transfer of additional columns to LIMS is now supported in the MultiQuantTM 3.0.3 software with the Audit
Trail and Security Features.

• The MultiQuantTM 3.0.3 software now remembers the sample being reviewed and the cursor stays on that
sample when the user navigates to a different analyte.

• Query functionality is now available if the MultiQuantTM 3.0.3 software version with the Audit Trail and Security
Features is installed.

Fixed Issues

The following issues have been fixed in this release:

Peak review image shown in the report does not match the image created in the MultiQuantTM

software

The image in the report looked different from the image created in the MultiQuantTM software peak review. The
report and the software now show identical images. This issue was only seen in MultiQuantTM 3.0.3 software.
(MQ-2233)

Mouse Cursor was flickering when upgrading the MultiQuantTM software

When upgrading the software to MultiQuantTM 3.0.2 version or the HotFixes, the issue of flickering mouse cursor
was experienced. (MQ-2801)

Peak Review right-click menu does not provide options to show narrowed integration
parameters or hide integration parameters (only applicable to the MultiQuantTM software
with the Audit Trail and Security Features)

(Only applicable to the MultiQuantTM software with the Audit Trail and Security Features)
In Peak Review and Side-by-Side Sample Review, the user did not have menu options to hide integration parameters,
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show narrowed integration parameters, show the highlighted graph with bold and italic font with white background,
or show the highlighted graph with grey background. (MQ-3559)

Installation Instructions

Prerequisites for Installing Using the DVD
The following are required to install and run the MultiQuantTM software. The logged on user must be an administrator
on the computer to install the software. For Microsoft Windows 7 and Windows 10 operating systems, the User
Account Control setting should be set to “Never notify”.

• Windows 7 with SP1 (32- or 64-bit) or Windows 10 (64-bit) operating systems

• .NET Framework 3.5 (SP1 or higher)

Note: On Windows 7 operating system, .NET 3.5 SP1 is installed by default. On Windows 10 operating
system, if .NET 3.5 SP1 is not already installed before the installation of the MultiQuantTM 3.0.3 software,
then the user is informed that .NET 3.5 SP1 is not installed and should be installed after the installation is
completed. Users should contact their IT department to install .NET 3.5 SP1.

Prerequisites for Installing Using the Web Site Download
If you are using the installer that was downloaded from the Web site, then the following prerequisite software
must be installed manually. The prerequisite software can be downloaded from the Microsoft Web site. The logged
on user must be an administrator on the computer to install the software. For Windows 7 and Windows 10 operating
systems, the User Account Control setting should be set to “Never notify”.

• Windows 7 with SP1 (32-or 64-bit) or Windows 10 (64-bit) operating systems

• .NET Framework 3.5 SP1. Refer to the note about .Net 3.5 in Prerequisites for Installing Using the DVD on page
5.

• .NET Framework 4.0

Additional Software Requirements
• Only the English versions of the Windows 7 operating system with SP1 and the Windows 10 operating system

are supported. The format for numbers, currencies, dates, and time must be set to English (United States).
Setting the format to a different value might result in erroneous data.

Installation Notes for Existing MultiQuantTM Software Users
Manually remove any previous versions of the MultiQuantTM software and all of the patches if applicable. Refer
to Remove the Software on page 8.
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If you are upgrading to the MultiQuantTM 3.0.3 software, then you must first remove the current version of the
MultiQuantTM software and then remove and re-install the Analyst Administrator Console (AAC) software on the
server, if you are using the AAC. Refer to Install the MultiQuantTM Software Update on the Analyst
Administrator Console (AAC) Server on page 7 for the information on how to upgrade the AAC server.

When using the AAC, only one version of the MultiQuantTM software with Audit and Security features (versions
2.x or 3.0.x) can be used in one organization because of the security settings.

When the MultiQuantTM software is installed again, the MultiQuantTM software security items are repopulated in
the Analyst

®
 software. Reconfigure the security settings after the installation.

Install the Software
A new license is required for the software to run after installation is finished.

1. Remove any previous versions of the software and all of the patches.

2. Run the setup.exe file.

3. Run the software.

4. Activate the licence.

5. On Windows 10 operating system, if .NET 3.5 is not already installed on the computer, then in Control Panel
> Program and Features, select Turn Windows features on or off.

The Windows Features dialog opens.

6. Select the .NET Framework 3.5 option to enable the install of .NET 3.5. IT permission might be required.

Figure 1-1 Windows Features Dialog
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7. After the installation, confirm the presence of .NET 3.5 in the Windows Features dialog. If it is installed, then
the .NET Framework 3.5 option will be selected.

Install the MultiQuantTM Software Update on the Analyst
Administrator Console (AAC) Server
If your organization is using the MultiQuantTM software with Audit Trail and Security Features and uses the AAC,
then update the AAC Server to add the MultiQuantTM software security items. The MultiQuantTM software update
file (AACUpdateSetup.exe) is located on the MultiQuantTM software installation DVD in the
InstallerAdminConsole folder.

1. In Control Panel, remove any previous versions of the Administrator Console Server - Update for
MultiQuant X.x if applicable.

2. Copy and paste the securitydb.odb file from the C:\Program Files (x86)\Administrator Console Server folder
to the same folder and then rename it to MQBackupSecurityDB.odb.

3. Double-click AACUpdateSetup.exe and then follow the on-screen instructions.

Install the Software on a Workstation Connected to the AAC
This procedure is only applicable if the MultiQuantTM software with Audit Trail and Security Features and the AAC
are used.

Note: If the workstation is connected to the AAC, then first disconnect the workstation from the AAC before
installing the MultiQuantTM software.

1. In the Analyst
®
 software, in Configure mode, click Tools > Settings > Administrator options.

2. Clear the Use Server Based Security check box.

3. Close the Analyst
®
 software.

4. Install the MultiQuantTM software.

5. If required, activate the licence.

6. Use the AAC client to check if the MultiQuantTM software security items exist. Click Roles > Administrator
> Properties.

Make sure that MultiQuant is present as a top-level security item. If it is not, then the update must be
installed on the AAC server. Refer to Install the MultiQuantTM Software Update on the Analyst
Administrator Console (AAC) Server on page 7.

7. Start the Analyst
®
 software.

Note: The Analyst
®
 software security must be set to Mixed Mode or Integrated Mode.

MultiQuantTM 3.0.3 SoftwareRelease Notes
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8. Reconnect the workstation to the AAC. Refer to the Analyst
®
 software Laboratory Director’s Guide.

9. Start the MultiQuantTM software from the Analyst
®
 software navigation bar.

Because the Analyst
®
 software is connected to the AAC, the MultiQuantTM software includes the security

permissions from the AAC security database.

Revert the Security Database
Use this procedure to remove the MultiQuantTM software security items from the Analyst

®
 software security

database. This procedure must only be performed on the AAC server by a user with administrator privileges.

CAUTION: The database is reverted to the last version of the database that was saved prior
to the installation of the AACUpdateSetup.exe. All security changes and all audit changes
made after the installation of the AACUpdateSetup.exe are lost if you revert the database.

1. Click Start > Run and then type CMD in the Open field.

2. Type net stop Poet in the command window. (Do not close the command window.)

3. Open the <drive>:\Program Files\Administrator Console Server folder where the AAC server is
installed.

4. Rename the securitydb.odb file to securitydb.bak.

5. Rename the MQBackupSecurityDB.odb file to securitydb.odb.

6. Return to the command window and then type: net start Poet.

The database is reverted.

Remove the Software
Remove the MultiQuantTM software before removing the Analyst

®
 software.

1. Open Control Panel.

2. Proceed as follows, depending on the operating system:

Windows 7 or Windows 10 Operating System

Click Programs or Programs and Features and then click Uninstall a program.

Click Uninstall.

During removal, you are prompted to remove the MultiQuantTM software configuration files. Keep the
configuration files if the MultiQuantTM software will be installed on the same computer at a later date.
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Notes on Use
• The MultiQuantTM software only integrates peaks within the detection window defined in the Analyst

®
 software

Scheduled MRMTM algorithm acquisition method. For Scheduled MRMTM Pro data using dynamic window
extension, MultiQuantTM software integrates peaks from where the detection windows starts to where it stops,
that is, from RT - 0.5 DetectionWindow to where the extended window stops, which is up to RT + 1.5
DetectionWindow. The detection window start and stop for each transition might not be where the acquisition
starts and stops.

• When opening a quantitation method created using the previous the MultiQuantTM software versions in
MultiQuantTM 3.0.1 software, the Outlier Settings is automatically filled with a default value. Users can
adjust the settings manually. The embedded quantitation method in the Results Table created from the
earlier version is not affected.

• The MultiQuantTM 3.0.1 software uses an updated WiffReader. This might have a slight impact on integration,
especially for MS3 and EMS data, most likely at the sixth or seventh digit of peak area and height.

• Processing data files while they are being acquired using network acquisition can cause conflict errors. To
avoid these errors, it is recommended to use a single injection per wiff file.

• For processing TOF data, Results Tables that contain over 10 000 rows might require a computer with more
than 4 GB RAM.

• Results Tables that contain over 100 000 rows might require a computer with at least 4 GB RAM.

• The license file becomes corrupted if users change the date on their computer to a date after the expiry date
of the license and then try to change the date back to the current date.

• English-only operating systems are supported.

• If Microsoft Office is not installed on the workstation, then the reporting functionality is hidden.

• Reporter queries must reside in the same folder as the Reporter templates.

• When creating reports in the CSV format, templates must not contain any picture tags.

• To make sure that reports are generated correctly, in the Components table of the quantitation method,
list all of the analytes at the top of the table and all of internal standards at the bottom of the table. Analytes
from the same group must be listed together and in the correct order. Groups cannot be mixed in the method.
If groups are mixed, then the columns in the report will be misaligned. The mixture of grouping and non-grouping
of analytes in the quantitation method is not supported. All the analytes are assigned to groups or all the
analytes are not assigned to groups.

• If you change the active project in the MultiQuantTM software and then return to the Analyst
®
 software, you

must select the new active project from the Project list. The Analyst software project list is not automatically
updated when the project is changed using the MultiQuantTM software.

• To make sure that the page up and down feature is working properly in the Side- by-Side Sample Review
pane, it is recommended that the number of rows in the pane are a multiplier of the number of components
in a group.

MultiQuantTM 3.0.3 SoftwareRelease Notes
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Upgrade from the MultiQuant 2.x Software
When viewing a version 2.1 .qmap file in the Audit Trail manager (viewing audit maps, editing audit maps, or
creating a Results Table), the software will set the Audited column to ON for every event that was not ON
previously. For all the other columns and predefined reasons, they will remain as is in the Audit Map Editor.
In the Audit Map Editor, the new 3.0.1 software events are added and the Isotope Correction is removed.

When opening a MultiQuant 2.1 software qSession file, the previously unaudited events are now audited silently
and the events are shown when the user clicks View Session Audit Map, but the Isotope Correction is
not displayed in the map. If this event was triggered before in the Results Table, it is shown in the Audit Trail
Viewer.

When creating a new Results Table, the active map used is upgraded. The previously unaudited events are now
audited silently and the new 3.0.1 software events are added.

Known Issues and Limitations
• In the Query dialog, when the All rows (visible and hidden) option is selected in the Apply query to field, then

the query is not applied to the hidden rows in the Results Table. The workaround is to first show the hidden
rows and then apply the query to both visible and hidden rows. (MQ-277)

• The fill down function Ctrl + D does not work on editable columns such as Actual Conc. and Dilution Factor.
To avoid this issue, switch the position of the Actual Conc. column with Outlier Reason and the position of the
Dilution factor column with the Retention Time column. (MQ-2305)

• Calibration equation is not recalculated when the internal standard (IS) is reintegrated and the changes are
applied for the first time. When the same changes are done and applied the next time, the calibration equation
is recalculated. This issue only affects the calibration equation shown in the UI of the Calibration curve. The
result is always updated when the internal standard is reintegrated. (MQ-2782)

• On Windows 10 operating system, the Installation Verification report does not open and a message about
pdfFactory not being installed is shown when the user attempts to print the report. To avoid this issue, make
sure that the computer is connected to the network. This issue does not affect the Installation Verification
feature. (MQ-3204)

• In the MultiQuantTM 2.1.1 software, when a Results Table containing custom columns such as "einwaage" or
"Auffuellung" is exported using File > Export > Results Table with options such as Analyst Format,
Export only visible columns, Export all rows except those explicitly hidden, then an error is generated. As a
workaround, exporting the Results Table without these custom columns works without any issue. Changing
the order of the columns also helps in exporting the Results table without any issue. (MQ-1778)

• (Only applicable to non-GLP version of the MultiQuantTM software) The MultiQuantTM software
cannot differentiate between two experiments with compounds having identical masses in the same period in
an automatic method. When processing this kind of automatic method, the software shows an error about
index being out of bounds. (MQ-1355)
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• (Only applicable to non-GLP version of the MultiQuantTM software) In the report, the custom
value generated by a query in the MultiQuantTM software can only be reported up to three decimals. (MQ-1964)

• If the Analyst Administrator Console (AAC) is used to manage people, then projects, and workstations, the
MultiQuantTM software allows users to access all projects regardless of the AAC workgroup settings. (ST032639)

• Users should not browse to a folder called Analyst Data unless it is the Analyst Data root folder created by the
Analyst software.

• Avoid using the same name for a custom column in the acquisition file and a column in the MultiQuantTM

software  Results Table. If the same name is used, then the information in the custom column is not read
in the Results Table. In addition to the columns listed in the MultiQuantTM software Reference Guide,
the Barcode and Scanned Barcode are also used exclusively by the MultiQuantTM software and must not
be used in the acquisition method. The column name is not case sensitive. (MQ-345)

• When Upper Limit concentration for flagging outliers in the quantitation method is used, any samples with no
peak found and shown as N/A in the Results Table are incorrectly flagged for Concentration. (MQ-548)

• Manual integration is not performed correctly when the user has set the options for Peak review as Overlay
Internal Standard with Analyte and Use a percentage y-axis. (MQ-549)

• For GLP users, local users who are assigned to the analyst role in the Analyst
®
 software cannot export and

then save Results Tables to a folder that has delete permissions denied. If users want to export and then save
the Results Tables, they have two options: They can either export the Results Tables to another location on
the hard drive, or they can select the same location and use the same file name and then save the files again.
(MQ-600)

• If a quantitation method containing empty fields for the concentration units is exported as a text file and then
imported as text, then the concentration units are populated using the value specified in the Units and Calibration
Defaults dialog. It is recommended that the user confirms that all of the information contained in the method
is correct before saving. (MQ-614)

Support

Additional Documentation
Refer to the documentation that comes with the software.

Contact Us
SCIEX Support

• sciex.com/contact-us

• sciex.com/request-support

Customer Training
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• In North America: NA.CustomerTraining@sciex.com

• In Europe: Europe.CustomerTraining@sciex.com

• Outside the EU and North America, visit sciex.com/education for contact information.

Online Learning Center

• SCIEXUniversity

For the latest guidance on cybersecurity for SCIEX products, visit
sciex.com/Documents/brochures/win7-SecurityGuidance.pdf.

Technical Support
SCIEX and its representatives maintain a staff of fully-trained service and technical specialists located throughout
the world. They can answer questions about the system or any technical issues that might arise. For more
information, visit the SCIEX website at sciex.com.
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Changes from Version 3.0.2 or HotFix1 to
MultiQuantTM 3.0.2 HotFix 2
The MultiQuantTM 3.0.2 HotFix 2 addresses the following issues:

Summing Ions from an Unequally Spaced Full Scan Data not Working Correctly

Issue MQ-2088 is fixed. Summing ions from an un-equally spaced full scan data was not working correctly. When
performing the summed ion calculation for a data type such as TOF IDA or Scheduled MRM HR, the summed
peak area might have been greater than the expected value.

Sum Multiple Ions Issue

Issue MQ-2009 is fixed. Previously, the summed peak area for some samples was greater than the sum of the
actual values of the peak areas for the individual ions. The summed peak area is now aligned with the sum of the
actual peak areas.

Scheduled MRMTM Pro Polarity Switch Data Processing Issue

Issue MQ-1833 is fixed. Previously, users were unable to process Scheduled MRMTM Pro polarity switched data.

The MultiQuantTM 3.0.2 HotFix 2 includes the following fixes addressed in MultiQuantTM 3.0.2
HotFix 1:

Sum Multiple Ions Issue

Issue MQ-2009 is fixed. Previously, the summed peak area for some samples was greater than the sum of the
actual values of the peak areas for the individual ions. The summed peak area is now aligned with the sum of the
actual peak areas.

Improvements to the processing speed operation

Issue MQ-1349 is fixed. Previously, “Set peak to ‘not found’” operated at a slower speed with the MultiQuantTM

3.0.2 software when compared with the MultiQuantTM 3.0.1 software. The speed of performance for version 3.0.2
is now similar to version 3.0.1.

Issue MQ-1895 is fixed. Previously, manual integration operated at a slower speed in the MultiQuantTM 3.0.2
software when compared to the speed of the manual integration in the MultiQuantTM 3.0.1 software. When this
HotFix is installed, the performance speed is now similar to the performance speed of version 3.0.1.
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Issue MQ-1937 is fixed. Previously, selecting or clearing a standard in a Results Table took more time when using
the MultiQuantTM 3.0.2 software when compared with the MultiQuantTM 3.0.1 software. The speed of performance
for version 3.0.2 is now similar to version 3.0.1.

Manual Integration Issue

Issue MQ-549 is fixed. Previously, an incorrect manual integration occurred when an analyte chromatogram was
shown in overlay mode with the "percentage y-axis" option selected for the intensity axis of the chromatogram.
The manual integration is now correct.

Changes from Version 3.0.2 to MultiQuantTM 3.0.2
HotFix 1
The MultiQuantTM 3.0.2 HotFix 1 addresses the following issues:

Sum Multiple Ions Issue

Issue MQ-2009 is fixed. Previously, the summed peak area for some samples was greater than the sum of the
actual values of the peak areas for the individual ions. The summed peak area is now aligned with the sum of the
actual peak areas.

Improvements to the processing speed operation

Issue MQ-1349 is fixed. Previously, “Set peak to ‘not found’” operated at a slower speed with the MultiQuantTM

3.0.2 software when compared with the MultiQuantTM 3.0.1 software. The speed of performance for version 3.0.2
is now similar to version 3.0.1.

Issue MQ-1895 is fixed. Previously, manual integration operated at a slower speed in the MultiQuantTM 3.0.2
software when compared to the speed of the manual integration in the MultiQuantTM 3.0.1 software. When this
HotFix is installed, the performance speed is now similar to the performance speed of version 3.0.1.

Issue MQ-1937 is fixed. Previously, selecting or clearing a standard in a Results Table took more time when using
the MultiQuantTM 3.0.2 software when compared with the MultiQuantTM 3.0.1 software. The speed of performance
for version 3.0.2 is now similar to version 3.0.1.

Manual Integration Issue

Issue MQ-549 is fixed. Previously, an incorrect manual integration occurred when an analyte chromatogram was
shown in overlay mode with the "percentage y-axis" option selected for the intensity axis of the chromatogram.
The manual integration is now correct.

Changes from Version 3.0.1 to Version 3.0.2

New Features
• The software now shows the Ion Ratios in Chromatogram for all sample types, including standards.
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• The software now shows the Expected Ion Ratio and Calculated Ion Ratio for all sample types in the Results
Table. The software also flags samples that are outside of the specifications for the Expected Ion Ratio.

• Enabled support for reports containing queries.

• Enabled support for reports in Word, csv and HTML formats.

• Added two new reporter tags: query name and report template name.

• Enabled the import of quantitation method as text.

• Enabled the export of quantitation method as text.

• Added new report and associated query: Sample Report With Concentration Threshold.

Fixed Issues
• After a Results Table is created, users should not remove a standard from the Results Table because the results

are not recalculated after the deletion. If users want to remove a standard, then save the Results Table after
deleting the standard and then close and open the Results Table again. (MQ-382/493) This issue has now been
fixed.

• Do not use the Export Calibration and Save Results Table or the Import External Calibration features found
under the Process menu. (MQ-387) This issue has now been fixed.

• When the user creates a report after external calibration is applied, the "Calculated Concentration" column
should not change. The column should retain the same values that were present before the report is generated.
(MQ-379) This issue has now been fixed.

• The quantitation method can be exported but the same method cannot be imported. Quantitation methods
containing an upper concentration limit that exceeds 100 cannot be imported into the software. (MQ-389) This
issue has now been fixed.

• For Results Tables that were created in version 3.0.1 or earlier, the previous behavior for Gaussian smoothing
for values below 0.3 is still applied even if the results are reprocessed. The scaling factor was incorrect for all
Gaussian smoothing values below 0.3. (MQ399) This issue has now been fixed for new Results Tables created
in theMultiQuantTM 3.0.2 software. If Gaussian smoothing values below 0.3 were applied during processing,
then it is advised to create a Results Table using MultiQuantTM software and reprocess the data.

• Ion Ratio outlier flagging is not applied to QC samples. (MQ-282) This issue has now been fixed.

Changes from Version 3.0 to Version 3.0.1

Note: No additional license activation step is required when upgrading from version 3.0 to version 3.0.1.

The following issues have been fixed.
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• When the administrator adds a user group to the Security Configuration and then connects that group to the
MultiQuantTM software, those users cannot run the MultiQuantTM software. Only the users who are added to
the Security Configuration as an individual user can run the MultiQuantTM software. This issue has now been
fixed. (MQ-283)

• Users can now export the correlation coefficient (r value) as an additional column in the exported text file.
(MQ-291)

• Support has been added for monocolor pictures in reports. (MQ-292)

• Previously, a created report was deleted when the discard changes option in Audit Trail was selected. This
issue has now been fixed. (MQ-289)

• The axis labeling in the chromatogram report is too small and difficult to read. Now the user can specify a font
size for axis and peak labeling in the template editor for each picture tag. (MQ-294)

• If there are compounds using the same MRM transition, then the Q1/Q3 transition for the first compound is
used for the later compounds if, after creating a Results Table, the user updates the method using the Edit
Results Table Method option and then resets the new typical sample. The new typical sample is a sample
from another .wiff file with the same compounds acquired but in a different order. This issue has now been
fixed. (MQ-342)

• In the previous release, incorrect data was shown in the  Results Table if all of these conditions were met:

• The Cache Chromatograms for Faster Peak Review check box was selected.

• The data files used to create the results had identical file names and were stored in separate folders.

• The user created multiple Results Tables simultaneously using the Results Table wizard.
This release resolves this issue so that these conditions no longer result in incorrect data in the Results
Table. (MQ-297)

Changes from Version 2.1.1 to Version 3.0
• Compatible with the Analyst

®
 1.6.2 software and supports the processing Scheduled MRMTM Pro Algorithm

data.

• Compatible with the Analyst TF 1.6 software.

• Compatible with data acquired with the AB SCIEX Triple QuadTM 6500 system and the QTRAP
®
 6500 system.

• Supports Microsoft Office 2010 and 2013 for reporting.

• Outlier Flagging flags the outliers for Accuracy for STDs & QCs, Ion Ratio, and Calculated Concentration.

• Enhanced Peak Review shows the indication of the Ion Ratio acceptance on an overlaid chromatogram. Users
can magnify single chromatograms.

• Side-by-Side Sample Review allows the user to choose up to six samples to compare the peak responses across
the samples.
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• Includes the following Results Table columns: Asymmetry Factor, Tailing Factor, Slope of Baseline, Ion Ratio,
Expected Ion Ratio, Outlier Reasons, Start Time at 5 %, Start Time at 10%, End Time at 5%, End Time at 10%,
Width at 5%, Width at 10%, Points Across Baseline, and Points Across Half Height.

• Enables the processing of UV, DAD, and ADC data.

• Supports an audited LIMS transfer to Watson using an Analyst software digital link.

• Supports an audited LIMS transfer though middle vendor.

• Supports the Analyst software .wiff file checksum.

• User receives a the License Expiry notification prior to 30 days of license expiry when starting the MultiQuant
3.0.1 software.

• Provides report tags to improve report functionality. (MQ145, ST035016)

• Corrects the issue where the "IS PeakReview" picture tag works only in the loop for the "ForEach Internal
Standard" instead of working with each chromatogram without the loop. (MQ102)

• Corrects the issue where the Metric Plot image report is not showing. (MQ105)

• Includes the Iterate field in the MultiQuant software exported text file for the Fit text line. This fix is also
applicable to the "MacQuan" and "Analyst" formats. (MQ106)

• The MultiQuant software data provider was updated to incorporate the current LIMS xml schema to address
parsing issues during transfer. (MQ119)

• Corrects the issue where users without delete privileges for the Project folders cannot save Result Tables.
(MQ142)

• Corrects the issue where the Analyst 1.6 software and the MultiQuant 2.1.1 software view data differently for
looped experiments with Scheduled MRMTM algorithm data. (MQ124)

• Corrects the issue where the data cannot be read under corrupted admin account in the Windows XP system.
(MQ163)

• Introduces secured report templates for the version with Audit Trail and Security features.

• For functionality available in the MultiQuant 3.0.1 software with Security and Audit Trail features, refer to the
Software Reference Guide.

Changes from Version 2.1 to Version 2.1.1
• Ensures compatibility with 4500 instrument series data.

• Updated LIMS communication module.

• MultiQuantTM 2.1.1 software installs Microsoft .NET Framework 4 Reliability Update 1 (KB2533523), that solves
the 64-bit simple query calculation issue (TT 34311).
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Notes on Use
To be able to generate reports on Windows 7, 64-bit, make sure that on the target computer, Microsoft Word
2007 or 2010 64-bit version is installed.

Changes from Version 2.0.2 to Version 2.1
• Improved flexibility:

• MultiQuantTM software without the audit trail and security features activated allows users to browse outside
the Analyst Data folder structure to access and store data.

• If the Analyst
®
 software is installed, the Analyst

®
 software data structure is supported.

• Per Sample Report, a new reporting option to accommodate large reports, is available.

• The MultiQuantTM 2.1 software can now generate and save very large Results Tables (up to 250 000 rows),
which fixed the memory issues reported in previous versions.

• In addition to supporting Microsoft Windows XP with SP3 operating system, the MultiQuantTM software now
provides support for the Microsoft Windows 7 with SP1 (32-bit) Professional operating system , and a Windows
7 (64-bit) operating system for the MultiQuantTM software version that does not include audit trail and security
features.

• Includes the ability to perform a 'file-less' transfer of data with LIMS software.

• Speed of query execution is now 10 times faster. (ST 029790)

• Query flexibility: if a custom column in a query starts with an underscore, the column will be hidden by default
in the Results Table. (ST 032075)

• The column order in the exported Results Table is now consistent with the column order in the user interface.
(ST 018829, ST 029512)

• The MultiQuantTM 2.1 software allows users to re-select a representative sample for quantitation methods.(ST
023725)

• Printing from the Audit Trail is now fixed by using the letter paper size. (ST 33654)

• In the Audit Trail, the Full User Name is now displayed and printed correctly. (ST 33654)

• The MultiQuantTM software is now integrating peaks correctly after the first peptide group in cases where all
transitions in the group were identical. (ST 032596)

• Upon opening Peak Review for the current .qSession file, the MultiQuantTM software verifies if the .wiff file
used to display the XIC from is the same as the .wiff file used initially to create the qSession file; if there is a
mismatch in the time stamp, the software will display an error message. (ST 033527)
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Reporting
• Reporter 3.2 software is integrated in MultiQuantTM 2.1 software.

• All Reporter templates installed by the MultiQuantTM 2.1 software are in the new file format .docx, which is
supported by the Reporter 3.2 software.

• To use an existing template that is not included in the list of installed templates, convert the template using
the ConverUI.exeutility located in the C:\Program Files\AB SCIEX\MultiQuant 2.1\TemplateConverter folder.

• To create or edit queries and generate or modify the report templates, then you need Microsoft Office 2007 or
Microsoft Office 2010 software.

• If you are using Microsoft Word 2003 on the target computer, then the reporting functionality requires that
the Office Compatibility Pack be installed. The Office Compatibility Pack can be downloaded at:
www.microsoft.com/download/en/details.aspx?id=3&WT.mc_id=
MSCOM_EN_US_DLC_MODULE_121LSUS007870.

Notes on Use
• Improvements to the smoothing algorithm may produce slightly different results when data is compared with

MultiQuant 2.0.2 software data.

• The license file will become corrupt if users change the date on their computer to a date after the license will
expire and then try to change the date back to the current date.

• Processing data files while they are being acquired using network acquisition can cause conflict errors. To
avoid these errors we recommend use a single injection per .wiff file.

• English-only operating systems are supported.

• If Microsoft Office is not installed on the workstation, then the reporting functionality is hidden.

• Results Tables that contain over 100 000 rows may require a computer with at least 4 GB RAM.

• Reporter queries need to reside in the same folder as the Reporter templates.

• When creating reports in the CSV format, templates must not contain any picture tags.

Known Issues and Limitations
• If the Analyst Administrator Console is used to manage people, projects, and workstations, the MultiQuantTM

software allows users access to all projects regardless of the AAC workgroup settings. (ST 032639)

• Reporting to secure .pdf format takes more time on Windows 7 than on Windows XP (ST 033918)

• The query functionality only supports .xls file format, it does not support .xlsx files.

• Users should not browse to a folder called "Analyst Data" unless it is the Analyst Data root folder created by
the Analyst software.
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• Creating reports in HTML format is restricted to workstations that have Microsoft Word 2007 SP2 or Microsoft
Word 2010 installed. Microsoft Word 2003 does not support creating reports in HTML format.

Changes from Version 2.0.1 to Version 2.0.2
MultiQuantTM Software 2.0.2 Installer

• If you are upgrading from a previous version of the MultiQuant software, the installer will automatically uninstall
that version before installing version 2.0.2. No data is lost during the installation. For more information, refer
to the MultiQuantTM 2.0.2 software Software Installation Guide.

Licensing
• Licensing support required to enable MultiQuant 2.0.2 software to register and activate licenses using the new

AB SCIEX licensing subsystem is now available. (ST 028212)

Reporting
• Support for MRM Ratio reporter queries. (ST 027697) Improvements to the smoothing algorithm may produce

slightly different results when data is compared with MultiQuant 2.0.2 software data.

• Creating reports in Word format when using the base or Scheduled MRMTM algorithm license is now available.
(ST 028201)

External Calibration
• External calibration is now applied correctly when using the Area metric. This is applicable in cases where an

external calibration for an analyte that does not use an internal standard is applied to one that does use an
internal standard. (ST 27516).

Known Issues and Limitations
Group analytes and standards to ensure reports are generated correctly.

To make sure that reports are generated correctly, in the components table of the Quantitation method, list all
analytes at the top of the table and all internal standards at the bottom of the table as shown in the following
screen capture. Analytes from the same group should be listed together.

Notes on Use
Previously, opening *.wiff files from network drives and from projects containing large numbers of *.wiff files in
the Results Table took several minutes. This issue has now been resolved.
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Changes from Version 2.0 to Version 2.0.1
Data Processing Support

MultiQuantTM software now supports processing of the AB SCIEX TripleTOF
®
 5600 system data. (ST 024542, ST

024040)

Fixed Issues
• MultiQuant 2.0.1 software can now be installed on non-English operating systems; however, MultiQuant

software is not officially supported on non-English operating systems. (ST 024466)

• MultiQuant 2.0.1 software can now be installed on the Analyst
®
 1.4.2 software. (ST 025359)

MultiQuant 2.0 Software Features (All Users)
• Ability to Add Samples from Multiple Batches and Multiple .wiff Files.

• Faster, Better: Speed Improvements:

• Faster Navigation: The user interface for MultiQuantTM software has been improved resulting in faster
navigation, including visual cues for row selection and fast sample assignment for multi-component samples.

• Faster Integration: Integration using the latest version of the Analyst
®
 software integration algorithm,

MQ4, is significantly faster for large MRM datasets, allowing users to review and edit the data more quickly.

• Introduction of the SignalFinder™ Integration Algorithm

• The SignalFinder integration algorithm is a new integration algorithm introduced with MultiQuant
2.0 software. By using peak modeling capabilities using a reference spectrum, this algorithm is able to
achieve impressive results, minimizing the need for manual integration of the data, or even for tweaking
data parameters.

• Dynamic Range Extension is achieved within the SignalFinderTM integration algorithm to extend the
upper dynamic range of a sample set by up to 30 times during cases where detector saturation predominates.

MultiQuant 2.0 Software Features (Regulated Users)
For customers operating in a regulated environment, for example a 21 CFR Part 11 or GLP Environment, MultiQuant
software incorporates many additional new features over the Analyst

®
 software Quantitation module.

MultiQuant software redefines the audit trail experience for quantitation. It provides fast navigation tools and
same-screen integration difference comparisons along with the audit trail entries.
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• MultiQuant Advanced Audit Trail Software

• Searching: MultiQuant software provides users the ability to filter through the audit trail quickly and
effectively.

• "Before and After" Review of Integration Data: By clicking on a sample in the audit trail, users
will immediately see the integrated chromatograms from both before and after the change was made.

• Results Table Lockdown and Fast E-Signatures

• After integrating the peaks, the user can lock down the Results Table. Only a user with the correct
role-assignment can unlock the Results Table after it is locked down. However, a QC reviewer can still log
comments about the Results Table in the audit trail. This enforces separation of roles, and ensures that
changes are not made in the review process without appropriate approval.

• E-Signatures on changes to integrations are consolidated, so that a single E-Signature signs off on the set
of events that changes a chromatogram, rather than performing multiple E-Signatures for each change.

Notes on Use
Previously, opening *.wiff files from network drives and from projects containing large numbers of *.wiff files in
the Results Table took several minutes. This issue has now been resolved. The date format in the Audit Trail Viewer
is mm/dd/yyyy. The time format uses the 24 hour clock. This format is not configurable.

If you change the active project in the MultiQuant software and then return to the Analyst
®
 software, you must

select the new active project from the Project list; the Analyst software project list is not automatically updated
when the project is changed using the MultiQuant software.

Known Issues and Limitations
Files must be saved following the Analyst

®
 Software file structure

In previous versions of MultiQuantTM software, files could be saved to any location. Now you must save your files
following the Analyst

®
 software file structure. All *.mquan files must be in the Results folder and all *.qmet files

must be in the Quantitation Methods folder.

Selecting samples may be slow if the Analyst
®
 software root directory is on the network

Selecting samples using the Create Results Table wizard may be slow if the Analyst software root directory is on
the network. (ST 19035)

MultiQuant software may close when users click inside message box

MultiQuant software may stop responding and close when users click inside the Save Quantitation Session, Save
Quantitation Method, or the audit trail message boxes. If this issue occurs, go to Control Panel > Regional
and Language Options > Languages Tab > Details Button > Advanced Tab and then select the
Turn off advanced text services option. (ST 19868)
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DateReason for ChangeRevision

September 2013First release of document.A

August 2014Added "Changes from Version 3.0 to Version 3.0.1". Added issue
MQ-342.

B

January 2015Added "Changes from Version 3.0.1 to Version 3.0.2". Updated
Known Issues and Limitations.

C

September 2017Changed AB SCIEX to SCIEX where required. Updated the copyright
page. Changed the company logo to Sciex. Added Changes from
Version 3.0.2 to MultiQuantTM 3.0.2 HotFix 1". Added Changes
from MultiQuantTM 3.0.2 HotFix to Version 3.0.3". Updated the
Prerequisites for Installing Using the DVD, Additional Software
Requirements, Install the Software, Remove the Software, and
Known Issues and Limitations sections. Removed all references
to Windows XP.

D
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